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Change History

Date Description
December 9, 
2022

Grade Entry: (page 20) Added details to How to Enter Withdrawal Grades

Course Overrides: (page 30) Added Time Frame to the filter
January 28, 
2023

Course Roster (page 37) - Added description of FERPA badge by students 
with FERPA restrictions.
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Symbols Used

These symbols are used alongside messages throughout the help to highlight various types of 
important information. The content of the messages varies depending on the topic being discussed.

This additional information may help you make decisions.

This hint may make your task easier.

This action may have unwanted consequences.

This action may have far-reaching or irreversible consequences.

A case study or scenario to explain a process or feature.

Depending on your school's licenses and your role's permissions, you may not have access to 
this feature.
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Faculty Hub

Information and features vary according to the roles to which you belong and the permissions 
associated with those roles. For more information, contact your module manager or your campus 
support team.

Watch this quick video to learn more about features and functionality in the Faculty hub. Faculty 
Overview video

This hub is where instructors and teaching assistants work with courses and students. Here you can

▪ Manage course sections
▪ View rosters
▪ Enter grades
▪ Grant overrides for registration
▪ Report attendance
▪ Contact students

Faculty Hub Overview Block
Information and features vary according to the roles to which you belong and the permissions 
associated with those roles. For more information, contact your module manager or your campus 
support team.

This feature is planned for a future release.
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Faculty Calendar Block
Information and features vary according to the roles to which you belong and the permissions 
associated with those roles. For more information, contact your module manager or your campus 
support team.

Use this block to see and plan your schedule. Your courses appear on the calendar on the days and 
times they occur. Click the course to see a summary of the course schedule with links to information 
for each course's location. Academic deadlines appear, too, such as the census date for attendance 
reporting, grade entry dates, and grade blackout dates.

You can view the calendar by agenda or by day, week, or month. You can also select this calendar on 
your home page.
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My Course Center Block
Information and features vary according to the roles to which you belong and the permissions 
associated with those roles. For more information, contact your module manager or your campus 
support team.

Use this block as a quick way to view the course sections you teach. The course code and the term for 
up to eight section appear in the block, sorted by Course Code in alpha-numeric order.
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Here's what you can do with the block:

▪ Use a saved filter to limit the types of courses that appear. (You can create and save filters on the 
My Course List page.)

▪ Jump to pages about each section:
◦ Section summary page
◦ Instructor summary page
◦ Roster
◦ Grade book

▪ Jump to the My Course List page showing all your courses with more details.

How To

View Your Course Sections
1. Use the My Course Center block in the Faculty hub.
2. To filter the sections, use the drop-down at the top right.
3. To see more details or your full list of courses, click View details on all courses. The My 

Course List page appears.
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View a Section's Summary Page
Course section titles appear as links in several blocks and pages. Click the link. The summary page 
appears.

View a Section's Roster
In the Select action drop-down for a section, select View roster. The section's roster page appears.

View or Enter Grades
In the Select action drop-down for a section, select Manage grades. The Grade Entry page appears.

FAQ

Why can't I view sections from past and future years?
Any of these might prevent you from seeing sections from other times:

▪ the selected filter
▪ the definition of active sections
▪ the registrar's restriction of past and future years in searches

The Registration Administration hub, the Registration module manager defines active courses, 
setting the number of days before a course begins and after it ends that it's considered active. 
The module manager can also restrict the number of past and future academic years available.

First, remove any filters restricting you. If that doesn't work, talk to the Registration module manager.

You can create filters on the Course List and My Course List pages. You can use them on those 
pages and on the Course Center and My Course Center blocks. Create a filter with no selections, 
and name it All Sections.

1. If you're on the Course Center block or My Course Center block, select a less restrictive filter, 
such as the All Sections filter recommended in the tip above.

2. If you're on the Course List page or My Course List page, go to the filter. Click Clear All and 
Apply.

3. If you still can't see the years you need, ask the Registration module manager whether any 
restrictions in the Registration Administration hub are preventing you from seeing past and 
future years.

Why is some information out of date?
Caching may prevent some information from updating. An iisreset on each J1 Web webserver will clear 
its cache and update the information.

Here's the technical information for your IT department:

The following data is cached on the J1 Web webserver so that J1 Web can perform better. These items 
do not change very often in the J1 Database, so we can cache the data on the J1 Web webserver. 

J1 Web Faculty 10



However, if the data does change, then an iisreset is needed. If you're load balancing, you need an 
iisreset on each J1 Web webserver.

▪ Allow Waitlisting setting in the Configuration Table in J1 Desktop "OVERENROLL" setting
▪ Course Title Format in Configuration Table "CRSTITLETODISP"
▪ Credit Labels in Division Def table
▪ Grade Table values in GRADE_TABLE
▪ RE departments
▪ Locations
▪ Years and Terms (This one has a 5-minute timeout, so when you add terms, they should show up 

in J1 Web within 5 minutes.)
▪ Override (Authorization) Reason
▪ Divisions
▪ License information

The following are settings in J1 Web. When the setting is changed, the cache is being updated, but if 
you're load balancing, you should perform an iisreset on each webserver.

▪ Active Courses Days Before
▪ Active Courses Days After
▪ Overrides Switch Setting
▪ Grade Entry Switch Setting

My Course List
Information and features vary according to the roles to which you belong and the permissions 
associated with those roles. For more information, contact your module manager or your campus 
support team.

Use this page to view the course sections you teach, whether you're the lead or an additional instructor. 
You can navigate to this page either from Hub options drop-down list on the Faculty hub or by 
clicking View details on all courses on the My Course Center block.

Sections appear 15 to a page. Above and below the list, you can navigate the pages or show all 
sections at once.

Filters
The list shows courses in which you're listed as one of the instructors. The filter status indicates the 
number of sections that passed through the filters. You can refine the list with a variety of filters and 
combinations, such as Keyword, Enrollment Status, Division, and Time Frame.

Filter types include text fields, type-ahead fields, drop-down lists, radio buttons, and date pickers.

You can save your filters for quick retrieval of the sections you want to see. Your saved filters are 
available here and on the My Course Center block.
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The Waitlisted option appears in the Enrollment Status drop-down list and in the quick filter above 
the list only if your school has waitlisting turned on in the J1 Desktop Registration Configuration 
window | Configuration Table tab | Exceeding Course Capacity group box.

In the Term drop-down list, you can type a year to jump to that year in the list. For example, you 
could type '2018' or just '18'.

Views
Use the view drop-down list to select a view. Each view displays different information about the 
sections.

Academic View
See typical academic information such as division, course state, lead instructor, and enrollment status 
for each course. The information comes from the Section Master table.

Course State
The Course State describes the section's progress. It's calculated from the section's begin and end 
dates, enrollment status, and the Canceled field. These are the values available:

Table 1. Values in the Course State Field

Course 
State

Description

Draft The section is not yet displayed in the Campus Portal. It is 
scheduled for a future term, and the Show on Web or Show 
in Campus Portal setting has 'None' selected.

Publish
ed

The section is displayed for end users. It is scheduled for 
a future term, and the Show on Web or Show in Campus 
Portal setting does not have 'None' selected.

In 
Progre
ss

e course has begun and has not yet ended. (That is, today's date 
is between First Begin Date and Last End Date.)

Pendin
g 
Comple
tion

The course has ended (today's date is after Last End Date), but 
there are students whose Enrollment Status = C Current, but who 
have no grade.

Comple
ted

The course has ended (today's date is after Last End Date), and 
all students have one of these statuses: D Dropped or H History.

Cancel
ed

The Canceled checkbox is selected.

More Details
There are more details under the expand icon .
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▪ Credit Hours
▪ Clock Hours
▪ Grade Type
▪ Requirement (the advising requirement that is satisfied by this course)
▪ Additional Faculty
▪ Location (as in the J1 Desktop Courses window | Course tab | Master 1 subtab | Course group | 

Course Location column;  and not any of the Location columns on the Courses window | Schedule 
tab)

Enrollment View
See enrollment status, capacity, current enrollment, and seats available, as well as the number of 
students waitlisted for the course. The information comes from the Section Master table, and is found in 
J1 Desktop on the Courses and Courses (Non-Traditional) windows | Course tab | Master 1 and Master 
2 subtabs.

Details under the expand icon  include actual vs. projected enrollment, maximum and minimum, 
preregistered, reserved, and dropped enrollments, as well as the current count and the history.

Schedule View
See the course meeting dates, days, and times, the location, and the faculty. The information comes 
from the Section Schedules table, and is found in J1 Desktop on the Courses and Courses (Non-
Traditional) windows |Schedule tab.

If the course has a complex schedule, the More link opens a pop-up with all the meeting times and 
places. The expand icon  reveals any hidden columns such as Where/Faculty.

Links
Anywhere you see the course code, it's a link to the course's summary page. Likewise, an instructor's 
name is a link to the instructor's summary page.
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How To

View My Course List
1. Open the Faculty hub.
2. In the Hub options drop-down, select View my course list.

Search My Course List
1. Click the filter icon .
2. Select filter checkboxes, and enter search phrases.
3. Click Apply to execute your search.
4. Click Save as to give your search a name and save it. It will appear in the filter drop-down on 

several pages.

See the "Search for Courses and Sections" topic for more details.

View a Section's Summary Page
The course title or course code (such as BIOL 1001 02) appears as a link in several blocks and lists. 
Click the link. The section's summary page appears.

View an Instructor's Summary Page
The instructor's name appears as a link in several blocks and lists. Click the link. The instructor's 
summary page appears.

View a Section's Roster
1. In the Actions column of the Course List, click the Select action drop-down list.
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2. Select View roster. The course's Course Roster page appears.
3. See the "Course Roster" topic for more details.

Manage Attendance for a Section
1. In the Actions column of the Course List, click the Select action drop-down.
2. Select Manage attendance. The course's Attendance page appears.
3. See the "Reporting Attendance" topic for more information.

View a Section's Grades
1. In the Actions column of My Course List, click the Select action drop-down.
2. Select Manage grades. The course's Grade Entry page appears.
3. See the "Grade Entry" topic for more details.

View or Create Course Overrides
1. Click the Hub options drop-down.
2. Select Manage course overrides. The Course Overrides page appears.
3. To grant a new override, click Create override.
4. For more information, see the "Course Overrides" topic.

FAQ

Why can't I see sections from past and future years?
Any of these might prevent you from seeing sections from other times:

▪ the selected filter
▪ the definition of active sections
▪ the registrar's restriction of past and future years in searches

The Registration Administration hub, the Registration module manager defines active courses, 
setting the number of days before a course begins and after it ends that it's considered active. 
The module manager can also restrict the number of past and future academic years available.

First, remove any filters restricting you. If that doesn't work, talk to the Registration module manager.

You can create filters on the Course List and My Course List pages. You can use them on those 
pages and on the Course Center and My Course Center blocks. Create a filter with no selections, 
and name it All Sections.

1. If you're on the Course Center block or My Course Center block, select a less restrictive filter, 
such as the All Sections filter recommended in the tip above.

2. If you're on the Course List page or My Course List page, go to the filter. Click Clear All and 
Apply.
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3. If you still can't see the years you need, ask the Registration module manager whether any 
restrictions in the Registration Administration hub are preventing you from seeing past and 
future years.

Why is some information out of date?
Caching may prevent some information from updating. An iisreset on each J1 Web webserver will clear 
its cache and update the information.

Here's the technical information for your IT department:

The following data is cached on the J1 Web webserver so that J1 Web can perform better. These items 
do not change very often in the J1 Database, so we can cache the data on the J1 Web webserver. 
However, if the data does change, then an iisreset is needed. If you're load balancing, you need an 
iisreset on each J1 Web webserver.

▪ Allow Waitlisting setting in the Configuration Table in J1 Desktop "OVERENROLL" setting
▪ Course Title Format in Configuration Table "CRSTITLETODISP"
▪ Credit Labels in Division Def table
▪ Grade Table values in GRADE_TABLE
▪ RE departments
▪ Locations
▪ Years and Terms (This one has a 5-minute timeout, so when you add terms, they should show up 

in J1 Web within 5 minutes.)
▪ Override (Authorization) Reason
▪ Divisions
▪ License information

The following are settings in J1 Web. When the setting is changed, the cache is being updated, but if 
you're load balancing, you should perform an iisreset on each webserver.

▪ Active Courses Days Before
▪ Active Courses Days After
▪ Overrides Switch Setting
▪ Grade Entry Switch Setting

Search for Course Sections with Filters
Information and features vary according to the roles to which you belong and the permissions 
associated with those roles. For more information, contact your module manager or your campus 
support team.

There are several blocks and pages where you can search course sections. Instructors use the My 
Course Center block and the My Course List page in the Faculty hub. Academic Departments use the 
Course Center block and the Course List page in the Academic Department hub.

J1 Web Faculty 16



Some settings on the Registration Administration hub affect filter results. They're in Registration 
Settings, Course Search Filter.

▪ Active Courses: Defines how many days before the course begins and after it ends that it's 
considered active

▪ Academic Years: Restricts the number of years past and future that are available for 
searching

Create and Save Filters
Both of the list pages let you create and save filters to search for sections you need to see. The saved 
filters are available on the Course Center and My Course Center blocks, too. You can also edit the title 
of a saved filter, make it the default, or delete it.

The keyword filter searches these fields:

▪ Course Code
▪ Title
▪ Grade Scale
▪ Credit Type
▪ Advising Requirement
▪ Division

Reset and Clear All
After you've started changing selections in a filter, you can reset filter's condition to how it was when 
you opened the page. Or you can clear all selections so that the list is unfiltered.
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Settings That Affect Filter Results
Some settings on the Registration Administration hub affect filter results. They're in Registration 
Settings, Course Search Filter.

How To

Apply a Filter
1. Click the filter icon  to toggle open the filter options.
2. Select checkboxes to activate particular filter options.
3. Enter or select search phrases. There may be drop-down lists, radio buttons, or free-type, or 

type-ahead fields. Some fields allow multiple selections.
4. Click Apply.

Save a Filter
1. Click the filter icon  to toggle open the filter options.
2. Select checkboxes to activate particular filter options.
3. Enter or select search phrases. There may be drop-down lists, radio buttons, or free-type, or 

type-ahead fields. Some fields allow multiple selections.
4. Click Save as.
5. Enter a name for the filter.
6. Click Save as. The filter is now available on the page and on the associated block.

Use a Saved Filter
1. Click the filter icon  to toggle open the filter options.
2. In the Saved Filters drop-down, select a filter.
3. Click Apply.

Edit a Filter's Name
1. Click the filter icon  to toggle open the filter options.
2. Click Edit.
3. Click the filter.
4. Edit the name.
5. Click Save.
6. Click Done editing.

Make a Filter the Default
1. Click the filter icon  to toggle open the filter options.
2. Click Edit.
3. Next to a filter, click Default.
4. Click Done editing.
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Delete a Filter
1. Click the filter icon  to toggle open the filter options.
2. Click Edit.
3. Next to a filter, click the Delete icon .
4. Click Done editing.

Clear a Filter
To remove all selections from a filter, click Clear all. Now you can either begin making selections again, 
or you can click Apply to view the list with no filters.

To return the filter to its last saved state, click Reset.

FAQ

Why does my search show no results?
Make sure you're searching in the correct fields. Keyword doesn't search every field, especially if 
there's another filter for the field. For example, if you want to find all sections with seats available, 
select Enrollment Status, and select Open from the drop-down list. (Using the Keyword filter won't find 
the open sections.)

Why can't I see sections from past and future years?
Any of these might prevent you from seeing sections from other times:

▪ the selected filter
▪ the definition of active sections
▪ the registrar's restriction of past and future years in searches

The Registration Administration hub, the Registration module manager defines active courses, 
setting the number of days before a course begins and after it ends that it's considered active. 
The module manager can also restrict the number of past and future academic years available.

First, remove any filters restricting you. If that doesn't work, talk to the Registration module manager.

You can create filters on the Course List and My Course List pages. You can use them on those 
pages and on the Course Center and My Course Center blocks. Create a filter with no selections, 
and name it All Sections.

1. If you're on the Course Center block or My Course Center block, select a less restrictive filter, 
such as the All Sections filter recommended in the tip above.

2. If you're on the Course List page or My Course List page, go to the filter. Click Clear All and 
Apply.

3. If you still can't see the years you need, ask the Registration module manager whether any 
restrictions in the Registration Administration hub are preventing you from seeing past and 
future years.
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How does the Date Range filter work?
If you set a date range, it includes any course sections that overlap the range at all.

You set a Date Range of 8/1/2021–12/31/2021. Results include sections that end as early as 
8/1/2021 or begin as late as 12/31/2021.

Why is some information out of date?
Caching may prevent some information from updating. An iisreset on each J1 Web webserver will clear 
its cache and update the information.

Here's the technical information for your IT department:

The following data is cached on the J1 Web webserver so that J1 Web can perform better. These items 
do not change very often in the J1 Database, so we can cache the data on the J1 Web webserver. 
However, if the data does change, then an iisreset is needed. If you're load balancing, you need an 
iisreset on each J1 Web webserver.

▪ Allow Waitlisting setting in the Configuration Table in J1 Desktop "OVERENROLL" setting
▪ Course Title Format in Configuration Table "CRSTITLETODISP"
▪ Credit Labels in Division Def table
▪ Grade Table values in GRADE_TABLE
▪ RE departments
▪ Locations
▪ Years and Terms (This one has a 5-minute timeout, so when you add terms, they should show up 

in J1 Web within 5 minutes.)
▪ Override (Authorization) Reason
▪ Divisions
▪ License information

The following are settings in J1 Web. When the setting is changed, the cache is being updated, but if 
you're load balancing, you should perform an iisreset on each webserver.

▪ Active Courses Days Before
▪ Active Courses Days After
▪ Overrides Switch Setting
▪ Grade Entry Switch Setting

Grade Entry in J1 Web
Information and features vary according to the roles to which you belong and the permissions 
associated with those roles. For more information, contact your module manager or your campus 
support team.

Use this page to enter or edit grades. Navigate to it either of these ways:

▪ From the Course Center or My Course Center or blocks, or from the Course List or My Course List 
pages, click Select action and select Manage grades.
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▪ From a course summary page, click Section options and select Manage grades.

Grading Period Views
Use the view drop-down list to select a grading period.

Midterm and Final grading periods are provided by default. Your school can add other periods in 
J1 Desktop on the Grading Period Definition window. There your school determines which columns 
display, which are editable, and which are required.

Your school can control which grading periods are available for courses in particular years and terms 
in J1 Desktop on the Year Term Subterm window, and you can assign grading periods to individual 
courses in J1 Desktop on the Courses window or the Courses (Non-Traditional) window. (See the 
"Setting Up Grade Entry" topic.)

Parent and child courses may have different grading periods assigned. You can enter or edit 
grades only when a grading period for the particular course section is open.

View, Enter, and Edit Grades
Enter or edit grades as you would in a spreadsheet. Once you begin entering information for a student, 
messages remind you if you're missing required information. The Save button is available when you 
have all required information in all the rows you've worked in.

Columns
Columns might or might not appear depending on several settings. Some of the settings are on the 
Grading Period Definition window. If columns are marked as Required on the Grading Period Definition 
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window, then here in Grade Entry you can't save until any row you've worked on has all the required 
columns filled.

Table 2. Columns Dependent on the Grading Period Definition Window
Column Description
Letter The grade from the grade table. Editable.
Comments Predefined phrases to select

Inactive comments can't be entered, but if they 
were already entered before being switched to 
inactive, they are still visible.

Remark A field for free-form text
Numeric Up to 3 digits before the decimal and 2 digits after (Edit mask 

= 0.00)
Narrative A field for free-form text
Grading 
Period 
Days 
Absent

Enter the number of absences during this grading period.

Total Days 
Absent

Enter the number of absences during the whole course.

Grading 
Period 
Clock 
Hours

Enter the number of clock hours the student participated in 
during this grading period.

Total Clock 
Hours

Enter the number of clock hours the student participated 
during the whole course.

Table 3. Other Columns
Column Description
Student Not editable
ID Not editable
Dual 
Enrollment

Available if your school has the Texas State Reporting license 
and dual-enrollment students. Not editable. If 'Yes', then both 
Letter and Texas Dual Credit Numeric Grade columns are 
required.

Texas Dual 
Credit 
Numeric 
Grade

Available if your school has the Texas state reporting license. 
If a student is dual enrollment, then this and the Letter column 
are required.

Start Date Available if your school is using Open Enrollment. Date is 
calculated when student registers.

End Date Available if your school is using Open Enrollment. Date is 
calculated when student registers.
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Column Description
Competenc
ies

Available if your school has the Competency Based 
Education (CBE) license and CBE is turned on. Appears 
for sections designated as Competency Based Education. 
(If the section is set up so that competency grades roll up 
to the section grade, you enter or edit grades. However, 
if the section is set up so that grades roll down from the 
section grade to the competencies, then you can't enter or 
edit grades for the competencies.)

Grading 
Type

Displays if the grading period uses a letter grade. Not 
editable. For Final and Midterm grading periods, this value 
comes from Student Course History. For other grading 
periods, it's based on Grade Scale and Credit Type from the 
J1 Desktop Courses or Courses (Non-Traditional) window | 
Course tab | Grading subtab.

Credits Credit hours. Not editable.
Last Date 
of 
Attendance

Editable only if required. Can be required only for final 
grading periods.

Athletics From the Course Roster. Not editable.
Degree 
Period

From the Course Roster. Not editable.

Midterm 
Letter

Included only in Final Grade period. Not editable.

Links
The Grade Entry page includes links to other pages and pop-ups.

▪ The Section icon  links to the section's summary page.
▪ The instructor's name links to their summary page.
▪ The Create new communication link opens the Create New Communication pop-up.
▪ The Edit Student Details link opens the Edit Selected Students pop-up. There you can edit 

student course history fields for the selected students simultaneously. (The link is available only if 
the selected students have the same Grading Type.

You can use the Edit Selected Students pop-up to apply a single grade (or remark, comment, 
etc.) to multiple students simultaneously.

Sorting the List
You can sort the list of students by any column. Click the column heading to sort by that column, 
ascending. Click it again to sort descending.

Sorting by the Grading Type column can be helpful for filling grades down or selecting multiple 
students whose details you want to edit.
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Filtering the List
You can filter the list by each column in the same ways you filter spreadsheets.

▪ By value: Select any or all of the values.

▪ By condition: Select a condition, and enter a value.

Reminders and To Dos
As a grading period approaches, if your school has turned on grade entry messages, you'll receive a 
notification reminding you to enter grades. You'll also receive a To Do item with a link to the Grade Entry 
page for the course. After you've finished entering the grades, be sure to mark your To Do complete. 
The registrar's office receives a message if the To Do isn't marked complete.
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Open Enrollment Sections
If a section is designated Open Enrollment, it can have only the final grading period. The day you enter 
a student's grade is set as the End Date in that student's student course history.

Permissions
Entering and editing grades requires permissions. While your school's permissions may be customized, 
in general,

▪ The Faculty role (and roles copied or created from it) can enter grades in open grading periods 
depending on the Web Grading Rights assigned to them in J1 Web on the Manage Section Details 
page, Faculty tab. (Web Grading Rights can also be assigned in J1 Desktop on the Courses 
window, Faculty tab.)

◦ Web Grading Rights distinguish between entering a grade (where there was no grade 
previously) and editing a grade (that is, changing an existing grade).

▪ The Department Head Course Access role and the Course Information – Access to All Courses 
role (and roles copied or created from them) can enter grades in open grading periods if they have 
the permission labeled "Can edit grades".

▪ Most users can enter or edit grades only when the grading period is open. However, the Registrars 
role (and roles copied or created from it) can always enter grades (even when the grading period is 
closed) if they have the permission labeled "Can edit grades".

How To

Enter or Edit Grades
1. Open the Grade Entry page one of these ways:

a. From the Course Center or My Course Center or blocks, or from the Course List or My 
Course List pages, click Select action, and select Manage grades.

b. From a course summary page, click Section options and select Manage grades.
2. Select a grading period from the drop-down list.
3. Enter grades as needed in any or all of the available columns. Some columns may not be 

required.
a. Letter: Select a grade from the drop-down.
b. Numeric: Type or paste up to 3 digits before the decimal and up to 2 digits after.
c. Comment:

i. Click the Manage button to open the Comments pop-up.
ii. Select the appropriate comments, and click Save.

d. Remark: Type or paste text. You can use ALT + Enter to start a new line.
e. Narrative: Type or paste text. You can use ALT + Enter to start a new line.
f. Competencies: This column appears only for Competency Based Education sections.

i. Click the Manage button. The Manage CBE Details for Student Section Record page 
opens. See "How to Enter Grades for Competencies" for detailed instructions.

ii. Enter information as needed.
iii. Click the Save button. The page closes.

4. Click the Save button. The page closes.
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Enter Withdrawal Grades
1. In the Letter field, select a withdrawal grade. (Some schools label such grades as W, WP, or 

WF.) The Withdrawal Details pop-up opens.
2. Enter information:

a. Withdrawal Reason: Required. Select from the drop-down. The options come from the 
Withdrawal Reason Definitions page.

b. Last Date of Attendance
c. Withdrawal Date: Required.
d. Add to count of withdrawals: Select the checkbox if this withdrawal should count toward 

a withdrawal limit. Withdrawal limits are set in Desktop on the Registration Configuration 
window.

e. Final Grade: The grade you entered is shown, but you can edit it.
f. Update midterm grade: Select the checkbox if you want to change the midterm grade.
g. Midterm Grade: Available only if the Update midterm grade checkbox is selected. Select a 

grade from the drop-down to replace the original midterm grade.

The Census Date and the Deadline to Withdraw Passing are visible for reference.

If the Deadline to Withdraw Passing is past, then you may not be able to enter a withdraw 
passing grade or a withdrawal grade, depending on the selections in Registration 
Configuration. An alert tells you what kind of grade you can enter.

3. Click OK. This enters your changes but doesn't yet save them to the student's record. The 
Withdrawal Details pop-up closes, so you're back on the Grade Entry page.

4. Enter other required and optional information for the student.
5. Click the Save button. The grade (including withdrawal information) is saved to the student's 

record.

Copy Grades to Other Students
Some familiar shortcuts from spreadsheets are available on the Grade Entry page.

▪ Copy and Paste: CTRL + C and CTRL + V
▪ Fill down: Move the cursor over the bottom-right corner of the cell to copy until the cursor changes 

to crosshairs. Hold the left mouse button and drag the crosshairs down over all the cells you want 
to paste into.

You can also use the Edit Selected Students pop-up to apply a grade to multiple students 
simultaneously.

1. On the Grade Entry page, select the students you want to receive the same grade. (They must 
have the same Grading Type.)
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2. Click the Edit Student Details link. The Edit Selected Students pop-up opens.
3. If necessary, click the Add another detail link, and choose the grade (Final, Midterm, Remark, 

Comment, Narrative).
4. Enter or select the value.
5. Click the Update button. The grade is applied to all the selected students.

Enter Grades for Competencies
If the section is a roll-up section (that is, grades roll up from the competencies to the section), then you 
can't enter grades on the Grade Entry page. Instead, you grade the competencies on other pages. The 
section grade is then automatically calculated from the competency grades.

To find out if the section is a roll-up section:

1. Click the Section icon . The section's summary page opens.
2. In the Section options drop-down, select Manage section details. The Manage Section 

Details page opens.
3. Click the Grading Controls tab. The CBE Grading Method field says 'Roll Up' or 'Roll Down'.

For roll-down sections, you can enter grades for competencies that are not required. (If they're 
required, they roll down from the section grade.) You can enter Remarks whether the competency 
is required or not.

To enter grades for individual students,

To Enter Competency Grades for Individual Students
1. On the Grade Entry page, in the Competencies column, click the Manage button. The Manage 

CBE Details for Student Section Record opens.
2. For each required competency, make a selection from the Grade drop-down. (You can select 

grades for non-required competencies, if you wish.)
3. If you wish, enter a Remark for any or all competencies.
4. Click the Save button. The section grade will be calculated and appear on the Grade Entry 

page. The Met column will be calculated from the Satisfies Advising Requirement field on the 
Grade Table Definition window in J1 Desktop.
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To Enter Competency Grades for Multiple Students at 
Simultaneously

1. Select the students that you want to give the same competency grade to. (For example, select 
all the students who are getting an A.)

2. Click the Edit student details link. The Edit Selected Students pop-up opens showing the 
required competencies that the students have in common.

3. Click the X on any student you don't want to grade now.
4. Click the X on any competency you don't want to grade now for the selected students.
5. Select a Grade.
6. If you wish, enter a Remark.
7. Click the Update button.

Some of the students you selected may have other required competencies (not in common with 
all the students you selected). Use the Manage button in the Competency column (Grade Entry 
page) to grade those other competencies.

Filter the Grade Entry List
1. Click the drop-down arrow on a column heading.
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2. To filter by the column's values, select checkboxes for the information you want to see.
3. To filter by conditions, select a condition, and enter a value.
4. To add more conditions, select the And or Or radio button, select another condition, and enter 

another value.
5. Click the OK button.

Email Students
1. Select one or more students.
2. Click the Create new communication button. The Create New Communication window opens.
3. Enter your subject and message information, include any needed attachments, and click 

Send button. If you are sending the email to more than one student, each will receive an 
individual copy of the email.

FAQ

Why can I edit grades for the parent course but not the child 
course?
The parent and child courses may have different grading periods assigned. You can only enter or edit 
grades during a grading period.

I entered grades. Why can't I edit them?
There are separate permissions for those tasks:

▪ Can view and enter grades for ungraded courses
▪ Can view and update grades for graded courses

Ask your module manager about permissions for your role.

Why can't I enter a Last Date of Attendance?
Some grades (such as withdrawal grades) may require a Last Date of Attendance, but only for final 
grading periods. If you can't enter a Last Date of Attendance, then either the grade doesn't require it or 
it's not the final grading period.

Why can't I enter grades in a roll-up section?
For roll-up sections, you grade the competencies. The section grade is calculated from the competency 
grades. See "How to Enter Grades for Competencies" above.

Roll-up and roll-down sections apply only to schools using the Competency Based Education 
features.

Why is only the final grading period available for a section?
The section may be Open Enrollment. Because students take Open Enrollment courses at their own 
pace, only the final grading period is available.
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Why is some information out of date?
Caching may prevent some information from updating. An iisreset on each J1 Web webserver will clear 
its cache and update the information.

Here's the technical information for your IT department:

The following data is cached on the J1 Web webserver so that J1 Web can perform better. These items 
do not change very often in the J1 Database, so we can cache the data on the J1 Web webserver. 
However, if the data does change, then an iisreset is needed. If you're load balancing, you need an 
iisreset on each J1 Web webserver.

▪ Allow Waitlisting setting in the Configuration Table in J1 Desktop "OVERENROLL" setting
▪ Course Title Format in Configuration Table "CRSTITLETODISP"
▪ Credit Labels in Division Def table
▪ Grade Table values in GRADE_TABLE
▪ RE departments
▪ Locations
▪ Years and Terms (This one has a 5-minute timeout, so when you add terms, they should show up 

in J1 Web within 5 minutes.)
▪ Override (Authorization) Reason
▪ Divisions
▪ License information

The following are settings in J1 Web. When the setting is changed, the cache is being updated, but if 
you're load balancing, you should perform an iisreset on each webserver.

▪ Active Courses Days Before
▪ Active Courses Days After
▪ Overrides Switch Setting
▪ Grade Entry Switch Setting

Course Overrides
Information and features vary according to the roles to which you belong and the permissions 
associated with those roles. For more information, contact your module manager or your campus 
support team.

Course overrides allow faculty and staff who have permission to allow students into courses they 
otherwise couldn't register for. In J1 Desktop, overrides are called Course Authorizations, and they're 
handled in your Campus Portal until your school decides to switch to the overrides features in J1 Web.

Setting Up Overrides in J1 Web
Course overrides are handled in your Campus Portal until your school switches to J1 Web Overrides. 
Then overrides will be handled only in J1 Web and not in the Campus Portal. Read about setting up for 
the switch in the "Switch to J1 Web Grade Entry and Overrides" topic.
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Permissions
Permissions are assigned on the Registration Administration hub, Registration Roles page. Permission 
to grant a particular type of override also allows you to revoke that type of override. These are pertinent 
permissions:

▪ Can view course overrides
▪ Can grant course full overrides
▪ Can grant registration permission required overrides
▪ Can grant course requisite overrides
▪ Can grant schedule conflict overrides

Roles based on the following roles have the above permissions by default:

▪ Faculty (to courses they teach)
▪ Department Head Course Access
▪ Registrars
▪ Course Information: Access to All Courses

Working with Overrides
Depending on your permissions, you can view, create, revoke, and reinstate filters. You can also search 
the list using filters.

Viewing
Access the Course Overrides page from the Hub options drop-down list on either the Academic 
Department hub or the Faculty hub. You can view overrides that were granted in courses you have 
access to.  By default, you'll see the most recent overrides per combination of student, course, and 
override type.

Creating (Granting), Revoking, and Reinstating
You can grant these overrides, depending on your permissions:
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▪ Course Full
▪ Course Requisite
▪ Permission Required
▪ Schedule Conflict

You can also email the student about the granted override. Select Create new communication from 
the Options drop-down.

To grant an override, use the Create override button to open the Create Override window. There you 
select the term, course, student, type, and reason. You can add a note, too.
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Values for the fields are defined in J1 Desktop, and the values for the Reason field are 
defined in a Maintain Table Values window for the Courses (or Courses Non-Traditional) window, 
Authorization tab, Reason column.

You can revoke an override that you have permission to grant. In the Action column, click Revoke. The 
Revoke window opens. Select a reason, and, if you wish, add a note.

You can reinstate a revoked override if you have permission to grant it. In the Action column, 
click Grant. The Grant window opens. Select a reason, and, if you wish, add a note.

Automatic Email to the Student
When you grant, deny, or revoke an override, the system notifies the student by email. However, the 
email is optional if you have this permission: 'Can skip sending email for student override'. In that case, 
a prompt asks whether you want to send or skip the email. The email text appears in the Course 
Overrides list.

Editing the Note
The Note field is editable if you have permission to grant this type of override.

Filtering Overrides
Filters help you search the list of overrides. You can select a saved filter or apply new search criteria. 
You can filter by a single attribute or combinations, and you can save filters to use again later. You can 
also edit the name of a saved filter, designate a default filter, reset filters to the last saved one, or clear 
all filters.
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How To

Create or Grant an Override
1. On the Academic Department or Faculty hub, click the Hub options, and select Manage 

course overrides.
2. Click the Create override button. The Create Override window opens.
3. Select the Term, Course, Student, Type, and Reason. Enter a Note if you wish.
4. Click Grant.

Grant a Requested Override
1. On the Academic Department or Faculty hub, click the Hub options, and select Manage 

course overrides.
2. In a row where the Status is 'Requested', click the Action drop-down, and select Grant. The 

Grant Override window opens.
3. Enter information in the required fields.
4. Click Grant.

J1 Web Faculty 34



Edit the Note in an Override
1. On the Academic Department or Faculty hub, click the Hub options, and select Manage 

course overrides.
2. In any row, click the Expand icon  to expand the row.
3. In the Note field, click the Edit icon .
4. Make your edits.
5. Click Save.

Revoke a Granted Override
1. On the Academic Department or Faculty hub, click the Hub options, and select Manage 

course overrides.
2. In a row where the Status is 'Granted', click the Action drop-down, and select Revoke. The 

Revoke window opens.
3. Enter information in the required fields.
4. Click Revoke.

Reinstate a Revoked Override
1. On the Academic Department or Faculty hub, click the Hub options, and select Manage 

course overrides.
2. In a row where the Status is 'Revoked', click the Action drop-down, and select Grant. The 

Grant window opens.
3. Enter information in the required fields, including Reason.
4. Click Grant.

Filter the Course Overrides List
1. Click the filter icon  to open the filter.
2. Select a saved filter, or select criteria and enter search phrases.
3. Click Apply to run your filter, or click Save as to save your criteria.
4. Click Reset filters to remove criteria you've selected or search phrases you've entered, and 

then click Apply.
5. Click Clear all to remove all filters, and then click Apply.

Make a Filter the Default
When saving or editing a filter, click Default next to the filter name.

Edit the Name of a Saved Filter
1. In the Saved Filters drop-down list, select a filter.
2. Click Edit.
3. Edit the filter name, and select it as default as you wish.
4. Click Save.
5. Click Done editing.
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Email Students
1. Choose the students you want to email by selecting the checkbox next to each name.
2. Click the Options button and choose Create new communication. The Create New 

Communication window appears.
3. Enter a subject, message, include any needed attachments, and click Send. If you are sending 

the email to more than one student, each will receive an individual copy of the email.

Section Overview Block
Information and features vary according to the roles to which you belong and the permissions 
associated with those roles. For more information, contact your module manager or your campus 
support team.

The Section Overview block is found on the Section Summary page and shows general information 
about the course section. Section information may include any of these:

▪ Schedule
▪ Credit Hours
▪ Clock Hours
▪ Division
▪ Advising Requirement
▪ Course State
▪ Grade Scale
▪ Credit Type

You can edit some of the information here, but for more editing, use the Manage Section Details page.

How To

Edit Section Information in the Section Overview Block
1. Click the Edit overview button.
2. Click the pencil icon  to edit a field.
3. Edit the information. (Some fields may not be editable, depending on your permissions and on 

various settings.)
4. Click the Save button.
5. Click the Done Editing button.

Registration and Counts Block
Information and features vary according to the roles to which you belong and the permissions 
associated with those roles. For more information, contact your module manager or your campus 
support team.
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This block appears in the Faculty hub and the Academic Department hub. Use it for a quick view of 
enrollment in a particular section. You can see quickly how many seats remain, and how many students 
are awaiting approval or still need to pay. 

Course Roster
Information and features vary according to the roles to which you belong and the permissions 
associated with those roles. For more information, contact your module manager or your campus 
support team.

Included Information
The course roster is displays information for each student including majors, programs, advisors, 
divisions, and classifications. You can check each student's registration status and contact them 
directly.

Column Description
Student (Name)
ID
Status Registration Status from Student Course History as of the year/term of the 

section
Classification From the Student Master table as of the year/term of the section
Major From the Student Master table
Actions Contact the student via message, email, or phone
Credits From Student Course History. Label may vary. Examples: UG Hours, Credit 

Hours.
Cross-Listed* Shows the parent-child relationships for cross-listed courses
Advisors Shows up to 2 primary advisors. Includes a Success Team link to the 

student's Advisee Spotlight page.
Current Division Student's current division on the Student Master table
Transcript 
Division

The division in which the course will count toward the student's GPA

Current 
Degree*

Student Program - Current on the Degree History Table

Degree 2* The earliest available additional degree
Athletics The student's sports
Graduation 
Stage

Example: Graduation Application Filed

Degree Period The student's projected degree period such as 2019 Degree

* Label isn't shown if no data is available.
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If the student's information is FERPA restricted, a badge labeled "FERPA Restricted" appears 
next to the student's name.

List View and Card View
The List View icon and the Card View icon toggle between list view and card view. The Students view of 
the Course Roster opens in list view by default.

List view and card view icons

In the list view, students appear 15 to a page. Above and below the list, you can navigate the pages or 
show all students at once. You can use the sort arrows  to arrange the list by one of the columns, or 
you can use the Sort by drop-down list.

The card view provides a handy glance at the same information but in a card form, including profile 
pictures if you wish.
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Options
Select one or more students and select an action in the Options drop-down list. The Options drop-down 
applies to all the students you select.

Email Selected Students
You can send an email to each of the selected students. (Each student receives an individual email 
rather than a group email.)

Register Selected Students in Another Section
On a section's Roster page, there's a convenient way to move students to a different section. This helps 
you balance enrollment in various sections or better fit the constraints of your facilities and schedules.

When you move students to a new section, you can select an option for what to do with the old section.

▪ Delete it (so it doesn't show in the student's course history)
▪ Drop it (so it appears as a dropped course)
▪ Keep it (so the student is enrolled in both)

J1 Web Faculty 39



After you click Done, a confirmation message appears. If there were registration errors that require an 
override, the Registration Overrides pop-up opens. If you have permission, you can override the error 
and complete the action.

Examples of error messages and override options:

Override a Section Full Error

Some Students Couldn't Be Registered
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An Advisor Must Approve

Filter
The filter card helps you find students that meet your search criteria. Click the filter icon  to open it.

By default, Registration Status is selected, and it's populated with these search phrases:

▪ Preregistered
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▪ Awaiting Approval
▪ Awaiting Payment
▪ Registered
▪ Graded

Thus, waitlisted and dropped students are filtered out by default. Deselect the Registration 
Status checkbox to see all students.

How To

View a Course Section's Roster
From the Course Center block, the My Course Center block, the Course List page, and the My Course 
List page:

1. Click Select Action for any course section.
2. Select View roster from the drop-down list. The roster opens to the Students view.
3. Click the Filter icon  to show the filter options.

a. Make filter selections, and click Apply to narrow the list of students.
b. Click Reset filters to revert the filters to the default selections. Then click Apply.
c. Click Clear all to remove all filter selections. Then click Apply.

4. Click the Expand icon  to view all the information for a student.

From any section's summary page:

1. Click Course options.
2. Select View roster from the drop-down list.
3. Make view and filter selections as above.

View a Student's Information Card
1. On the Course Roster page, click the Card View icon .
2. Find the student's card.
3. Click the Flip icon  to flip the card over.

Print a Course Section's Roster
A robust feature that allows you to download the roster to an Excel spreadsheet (and then arrange and 
print it) is planned for a future J1 Web release. Until then, here are some ways you can get print or 
download the roster. Some of the methods require access to the J1 Desktop application. If you don't 
have access, you could ask the registrar's office or your campus support team to do this for you.

1. To print from the browser window, press CNTRL + P or use your browser's menu. The printout 
includes the first several columns of the roster.

2. To generate a J1 Desktop Class List Report (PDF):
a. In J1 Desktop, access the Class List Report window.
b. Select the Year and Term.
c. In Start Course, select the course section.
d. In End Course, select the same course section.
e. Click Print. The pop-ups prompt you to select the folder to save the file in.
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3. To print the class list from the J1 Desktop Courses window (PDF or other):
a. In J1 Desktop, access the Courses window.
b. Enter the Year, Term, and Course section.
c. Click the Class List tab.
d. On the main menu, click File > Print. The Print window gives you options for the format to 

save in, such as PDF and OneNote.
4. To save rows to another application from the J1 Desktop Courses window (Excel or other):

a. In J1 Desktop, access the Courses window.
b. Enter the Year, Term, and Course section.
c. Click the Class List tab.
d. On the main menu, click File > Save Rows As. The Save As pop-up lets you select a folder 

and a file type. We recommend Excel 12 with headers for the file type. There are many 
columns, and while the student's ID is in Column D, their name is far to the right in Column 
CC. You can rearrange the columns in Excel.

Search or Filter the Course Roster
1. Click the Filter icon  to show the filter options.
2. Select any checkboxes.
3. Enter search phrases. Some are drop-down lists; others are free-text fields. All allow multiple 

entries.
4. Click Apply.
5. To change your filter combinations, make other selections, and click Apply again.
6. To save your filter combination, clickSave as.

a. Enter a name.
b. If you wish, select Set as default so the filter is applied by default when you open the page.
c. Click Save.

Contact Students on the Roster
1. On either the list view or card view, select one or more students.
2. Click the Options drop-down, and select Create new communication. The Create New 

Communication pop-up opens.
3. Enter your message information, include any needed attachments, and click Send. If you are 

sending the email to more than one student on the roster, each will receive an individual copy of 
the email.

Move Students to Another Section
1. On a section's Roster, use the list view.
2. Select one or more students.
3. In the Options drop-down, select Register in another section. The Register Students in 

Another Section window pops up.
4. Select the Term, Section Code, and Enrollment Status for the new section.
5. In the Action drop-down, select what happens to the old section: drop, delete, or keep.
6. Click the Register button.
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FAQ

Why can't I see waitlisted and dropped students?
By default, waitlisted and dropped students are filtered out of the course roster. To see them, deselect 
the Registration Status checkbox in the filter. Or, to change the combination of registration statuses 
you see, keep the checkbox selected, and add or remove search phrases from it.

Why is some information out of date?
Caching may prevent some information from updating. An iisreset on each J1 Web webserver will clear 
its cache and update the information.

Here's the technical information for your IT department:

The following data is cached on the J1 Web webserver so that J1 Web can perform better. These items 
do not change very often in the J1 Database, so we can cache the data on the J1 Web webserver. 
However, if the data does change, then an iisreset is needed. If you're load balancing, you need an 
iisreset on each J1 Web webserver.

▪ Allow Waitlisting setting in the Configuration Table in J1 Desktop "OVERENROLL" setting
▪ Course Title Format in Configuration Table "CRSTITLETODISP"
▪ Credit Labels in Division Def table
▪ Grade Table values in GRADE_TABLE
▪ RE departments
▪ Locations
▪ Years and Terms (This one has a 5-minute timeout, so when you add terms, they should show up 

in J1 Web within 5 minutes.)
▪ Override (Authorization) Reason
▪ Divisions
▪ License information

The following are settings in J1 Web. When the setting is changed, the cache is being updated, but if 
you're load balancing, you should perform an iisreset on each webserver.

▪ Active Courses Days Before
▪ Active Courses Days After
▪ Overrides Switch Setting
▪ Grade Entry Switch Setting

Reporting Attendance
Information and features vary according to the roles to which you belong and the permissions 
associated with those roles. For more information, contact your module manager or your campus 
support team.

Use a course's Attendance page to view attendance and to report on it. The report drop-down lists 
the kinds of reports: Checkpoint reports for attendance at particular class meetings, and Census Date 
reports to report who never attended and who's no longer attending.  Each active checkpoint report that 
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your school has defined is visible, and it's available during its reporting period. The census date report 
is also available during its reporting period.

After you submit your attendance reports, the registrar's office processes them, dropping or withdrawing 
students as appropriate.

View Attendance
For each student, you can see the types of attendance reports, the report status and when it last 
changed, the last date of attendance (if pertinent), and a comment.

The Status indicates where a report is in the process.

For Census Date reports

▪ Submitted – The instructor has submitted a Census Date report, but the registrar has not yet 
processed it.

▪ Dropped – The instructor reported the students as Never Attended or No Longer Attending, and 
the registrar dropped the student from the course.

▪ Withdrawn – The instructor reported the students as Never Attended or No Longer Attending, and 
the registrar withdrew the student from the course.

For Checkpoint reports

▪ Attended – The instructor marked the student as present in a checkpoint report, and the registrar 
processed the report.
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▪ Did Not Attend – The instructor marked the student as not present in a checkpoint report, and the 
registrar processed the report.

▪ Denied – The instructor submitted a Checkpoint report, and the registrar rejected it.

Submit Attendance Reports
You'll receive To Do when it's time to report on attendance for a particular course. The task has a link to 
the Attendance page for the course. Select a report type, select students, and select a report from the 
Options menu.

For cross-listed courses, you may be able to report attendance for a child course from within the 
parent course if the parent and child courses have the same report date. But if the parent and 
child courses have different report dates, go to the child course to report its attendance.

Your school may exclude some courses from attendance reporting.

Submit Census Date Reports
There are two types of census date reports: one that lists who on the roster had never attended by the 
census date, and the other that lists who stopped attending by the census date. Your school might use 
either, both, or neither. For No Longer Attending Reports, a prompt asks for the student's last date of 
attendance.
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Submit Checkpoint Reports
Checkpoints are for reporting who is in class on a specific day, such as the 3rd class meeting. Your 
school creates checkpoints, so there might be none, one, or several. The registrar's office can name 
them as they wish, but typical names might include Day 2, Meeting 5, or Checkpoint 10.

For checkpoints, you mark students either as Attended or Did Not Attend.

Contact the Registration Office
You can contact the registration office about a particular student on the list using the Select 
action button for that student. Or you can start a more general message with the Message 
colleague icon.

How To

View Attendance
From the Course Center block, the My Course Center block, the Course List page, and the My Course 
List page:

1. Click Select action for any course.
2. Select View attendance from the drop-down list.
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3. On the Attendance page, select a report from the view drop-down list.
4. Click the Expand icon  to view all the information.
5. Use the Sort arrows  to sort by a column.

From a course's Summary page:

1. Click Course options.
2. Select View attendance from the drop-down list.
3. On the Attendance page, select a report from the view drop-down list.
4. Expand and sort as above.

Submit Attendance Reports
1. View the Attendance page for a course.
2. Select a report from the view drop-down list.
3. Select students. You'll report one attendance status at a time, so select all the students you want 

to report as one status:
▪ Attended or Did Not Attend (for checkpoint reports)
▪ Never Attended or No Longer Attending (for census date reports)

4. Click Options, and select a report status from the drop-down list.
5. Census date reports have a report pop-up.

a. You can enter or edit the Comment and click Apply to save the comment.
b. For No Longer Attending reports, enter a Last Date of Attendance.

6. Click Save to submit the report.

A report is enabled only during its reporting period.

Quick method for checkpoints

1. Select all.
2. Click Options and Report attended.
3. Click the Status column to sort by it.
4. Select students who did not attend.
5. Click Options and Report did not attend.
6. Click Save to submit the report.

Correct an Attendance Report
Just repeat the steps to submit an attendance report—this time with the correct information. If this 
doesn't work (because the reporting period is closed, for example), contact the registration office.

Send a Message to the Registration Office
To send a message about a student on the attendance list:

1. Click Select action.
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2. Select Message Registrar from the drop-down list.

To send a message that's not bout a particular student:

1. On the page toolbar, click the Message colleague icon . The Send Message pop-up appears 
with the registration office email address in the To column.

2. Follow the prompts, and click Send message.

Contact Students
1. Select one or more students you want to contact.
2. Click the Options drop-down, and select Create new communication. The Create New 

Communication window opens.
3. Enter your message information, include any needed attachments, and click Send.

FAQ

Can I make corrections to submitted reports?
Yes, as long as the reporting period is open. Just report the student again, this time with the correct 
attendance type.

If reporting period is closed, click the Select action button, and select Message Registrar. Also 
contact the registrar if a student is attending but you marked them as Never Attended or No Longer 
Attending. 

Why can't I submit an attendance report?
Each report is available only during its reporting period. It's disabled all other times.

Why can't I submit reports for students in a cross-listed 
course?
If the parent and child courses have the same report date, you can report attendance for child courses 
in the parent course. But if the parent and child courses have different report dates, you have to go to 
the child course to report its attendance.

Why is some information out of date?
Caching may prevent some information from updating. An iisreset on each J1 Web webserver will clear 
its cache and update the information.

Here's the technical information for your IT department:

The following data is cached on the J1 Web webserver so that J1 Web can perform better. These items 
do not change very often in the J1 Database, so we can cache the data on the J1 Web webserver. 
However, if the data does change, then an iisreset is needed. If you're load balancing, you need an 
iisreset on each J1 Web webserver.

▪ Allow Waitlisting setting in the Configuration Table in J1 Desktop "OVERENROLL" setting
▪ Course Title Format in Configuration Table "CRSTITLETODISP"
▪ Credit Labels in Division Def table
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▪ Grade Table values in GRADE_TABLE
▪ RE departments
▪ Locations
▪ Years and Terms (This one has a 5-minute timeout, so when you add terms, they should show up 

in J1 Web within 5 minutes.)
▪ Override (Authorization) Reason
▪ Divisions
▪ License information

The following are settings in J1 Web. When the setting is changed, the cache is being updated, but if 
you're load balancing, you should perform an iisreset on each webserver.

▪ Active Courses Days Before
▪ Active Courses Days After
▪ Overrides Switch Setting
▪ Grade Entry Switch Setting

Programs Block
Information and features vary according to the roles to which you belong and the permissions 
associated with those roles. For more information, contact your module manager or your campus 
support team.

Use this block to see at a glance a student's majors, minors, concentrations, and certifications. If the 
student has more than one program, you can click each one to view its details. A student may have 
current, active, and completed programs, as well as incomplete previous programs.

The block also shows the student's entry and catalog years, as well as their expected graduation date. 
Finally, you can see whether the student is on track with their academic plan.

Program information comes from the J1 Desktop Student Information window, Degree tab.

▪ Current Program
◦ the row in Degree History that's flagged as both Current Degree and Active

▪ Active Program
◦ a row in Degree History that's flagged as Active but not as Current Degree
◦ The block displays up to two Active Programs in addition to the Current Program.

▪ Completed Program
◦ a row in degree history that has a date in Date Conferred

▪ Previous program
◦ a row in Degree History that has a date in Exit Date but not in Date Conferred
◦ The block displays up to three programs marked as either Completed or Previous.

If not all the information fits on the screen, a More link connects you to the rest of the information.
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How To

View a Student's Programs
1. Open the Course Roster page for any course.
2. Click a student's name. The student's Summary page opens and includes the Programs block.
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Jenzabar Academy Feedback

Help the Help
Please let us know if you have any recommendations, issues, or feature requests you may have for 
the J1 Desktop, J1 Web, and Campus Portal help products.

Take our survey See our resources Watch our videos Send us an email

We're Here for You
We're always happy to help, or just to say hello! Your suggestions are important to us and help us 
constantly improve our help products.
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